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Introduction

CalcOne is a universal calculator that embodies many useful features and 
functions. It was designed with two things in mind: We want to offer a calculator with 
broad appeal and to insure the program uses very little program memory. Currently 
version 2.0 has scientific functions, financal calculations, does unit conversions, base 
conversions. The calculator will operate normally whether it is registered or not. 
However, until the calculator is registered, a reminder will be displayed and the user will 
have an opportunity to enter a registration number. A registration number can be 
obtained from 

Fantron Design Ltd.
242 Sugar Road
Bolton, MA 01740

by sending $12.50 and your name and address. With your registration, you will receive 
the next upgrades for free. We are planning to add stand alone applications that make it
easy to edit and merge data files, customize menus.

CalcOne is a universal shareware calculator program that can be operated in an 
algebraic (Standard) or Reverse Polish Notation (RPN) entry modes. If you don't have 
your own registration number, registration information can be found under the About 
CalcOne... menu item under the Help    menu



Quick Start Guide

When starting CalcOne for the first time, a dialog box will appear that notifies you
the program isn't registered.    If you have a registration number, click on YES, and enter
your registration number in next dialog box. There are times when you will need to 
register again. This may occur when you reset the program,    switch computers, or 
system software. If you loose your registration number, write us at the address above. 
Give us your name and address, and we will send your registration number again.

To start the calculator, double click on the CalcOne icon. After registering, a 
picture of a calculator will appear on the computer screen. The calculator buttons are 
actuated by positioning the mouse's arrow over a calculator key and click once with the 
mouse button. As with other applications, most functions have a key board equivalent, 
some of which are shown to the right of the menu item.

When the calculator appears, notice the menu items in the menu bar at the top of
the window. Click on the Mode menu, and you can chose between Standard and RPN 
entry modes as well as other features relating to the calculator operation. For those who
like the Hewlett Packard calculators, chose the RPN menu item. For the more common 
algebraic entry system, chose the Standard menu item.

Also notice the Calculator menu. There are five calculators under this menu item
which can be chosen. The Scientific calculator performs many logarithmic and 
trigonometric calculations. The Complex calculator performs these same functions with 
complex (real and imaginary) numbers. A Financial calculator will perform statistic and 
interest rate calculations. The Conversions calculator will convert from one unit 
measure to another, like meters to yards. And a Numerical calculator which does base 
conversions and logical operations has been added to version 2.0. Each of these 
calculators are discussed in detail in the following sections.



General Instructions

Some operations will be common to all five calculators and this section describes
these general operating procedures. This section can be skipped by those who are 
familiar with other calculator products.



Preferences  :  

Under the Calculator item in the menu bar, there is a Preferences... menu item 
that allows you to set the color of the calculator and the type of decimal point you want 
to use. When you select preferences, a dialog box will appear with check boxes for the 
type of decimal point, a period "." or a comma ",". There will also be three scroll bars for 
setting the calculator color. The color is set by sliding the red, green and blue control, 
untill the small square in the bottom-right is the desired color. 



Standard   Entry Mode:  

In the Standard mode, numbers and the six operations 

 +, -, x, /, =, and [ ] 

are entered like an algebraic equation:

1      .      2      X      [( )]      2    +      .      8      [( )]      =  3.36

The key board can be used as long as you substitute the star * for the multiplication and
the forward slash, /, for the division buttons.    The calculator should automatically know 
whether the [()] is an open, "[", or close, "]", and there can be up to 6 levels of [( )]. 

The button Clr cancels any pending operation and sets the display to zero.

RPN   Entry:  

In the RPN entry mode, the mathematical operation is entered last.    The first 
number is stored by clicking on the E (ENTER) key, followed by the second number and
so on. Then, the math operations are entered from last to first, and no equal sign is 
needed.

1      .      2      E      2      E      .      8      +      X      3.36

The key board can be used as long as you use the star * for the multiplication and the 
forward slash, /, for the division buttons. The numbers you enter are stored in four 
registers that can be "rolled" by using the down arrow key. Try entering;

1      E      2      E      3      E      4

and then click on the down arrow key several times. These four numbers will reappear 
in reverse sequence.

The Clr key only clears the display, x value, in memory. it has no effect on the other 
registers.



Display and Operation Instructions  :  

The left arrow is used to correct the number being entered. One-by-one, the last 
key stroke will be removed form the number in the display.

1      .      2        8        7        <-      <-      <-      = 1.2

The +/- key changes the sign of the number in the display.

The FIX key is used to control the format of the display and the number of digits 
displayed. Four display modes can be selected with this key and the current setting is 
displayed as a small code in the top of the display window the first time FIX is selected;

Scientific S: displays the number as power of 10
Literal L: displays the number with a fixed number of decimals
Engineering E: displays the number in powers of 1000
Fixed F: displays the number in a fixed number of decimals but 

will switch to scientific when the number gets too big 
or too small.

Along with the little letter, a number will appear that shows the current setting for the 
number of digits after the decimal. This number will range from 0 to 9. There may be a 
letter F instead of a number. When FIX is selected, the current decimal point mode and 
number of digits are displayed. If this setting is OK, select any key except a number, 
decimal point, or FIX. Selecting FIX again or again will change the decimal point mode 
from S to L to E to F and back to S until you have selected the desired display mode. 
The very next number you select will determine the number of digits after the decimal 
point. If the decimal point key is selected , the number of digits after the decimal point 
will "float". This means the last digits after the decimal are checked to see if they are 
zeros, and if they are, these zeros are not displayed.

The EE is used to enter a power of ten.

The x-y swaps the value displayed and the last value entered.

The Sqr key finds the square root of the display if it is positive.

The 1/X key finds the inverse of the display.

The X2 key squares the display.

The STO key is used to store numbers in any of the 10 memory locations.    
When you want to store a number, click on the STO key and a number between 0 and 
9. When the STO key is selected, a small STO is displayed at the top of the display 
window. Along with the little STO will be a number. This is the default memory location. If 
any key is selected other than a number, the default memory location will be used for 



storage. The function can also be invoked from the keyboard with the "s" key

The RCL key works the same as the STO key, but recalls the value at    the 
memory number selected, or the default. Recall can also be chosen by pressing "r" on 
the keyboard.

The INV key turns the invert indicator on and off in the upper left hand corner of 
the display. When the INV is active, some of the function keys will operate in the inverse 
mode. For example, sin becomes arcsine. 

Displayed values can be cut and pasted into other applications by using the 
menu items under the Edit menu item. To get the number form the display, select the 
Copy menu Item under the Edit menu. Then, go to your other document or application 
and paste that number in. Numbers can pasted into the calculator from other documents
by selecting the Paste menu item.    Cut or Copy the number from your other document, 
activate CalcOne, and select Paste. The number will appear in the display as if you 
entered it with the mouse or from the keyboard.

The Reset menu item will reset the calculators screen position, memory 
registers, operating modes and display options to a state similar to when you first 
started this program. 

The calculator takes up a lot of room on the desktop. You can miniaturize the 
calculator by clicking on the bar below the display window. Another click on the bar will 
return the calculator to its normal size.

To get rid of the calculator, you can chose Exit from the File menu or click in the 
tiny box in the upper left hand corner of the calculator window. Your calculator position 
on the screen, and other settings will be saved before the program quits. Next time you 
start the program, you can continue calculating where you left off. However, if you want 
to use the calculator for several different jobs, such as your monthly budget and your 
business finances, you can write data into files as explained in the next section.



Data Storage and Retrieval:

Data can be written into a file or read from a file that has already been created. 
This can be valuable for saving different data files for each sales account, for your home
finances. Running balances can be kept in the memory location or in the display, and 
recalled at any time. The following is a list of calculator items saved in the data file 
(version 2.0):

Display and all stack items (RPN Mode).
All 10 memories and default numbers for STO, RCL and SUM.
RPN/Standard setting, calculator, and decimal point type.
Decimal point and Complex number Mode, angle type (e.g.. radians)
Calculator color and location on screen.

To save a file, select the Save or Save As...    menu Item under the File menu in 
the menu bar. Selecting Save will write over the last file you wrote, or if this is the first 
save since you started the calculator, the data will be saved in a file named ClacOne.dat
in the current directory. Chose Save As... if you want the data saved in another file. 
Then, use the standard save as... dialog box to navigate and save the data.

If you want to load data from a CalcOne file, select Open from the File menu in 
the menu bar. Then navigate with the standard file dialog box until you find the file you 
want.



Paper Tape  :  

CalcOne 1.0 has a paper tape display where up to 64 numbers and operations 
can be printed. The paper tape is started by selecting the Paper Tape menu item under 
the Mode menu. The paper tape is just a window where a history of calculator 
operations and results are written. Only eight lines are shown, but there are 64 stored in
the records and can be viewed by using the sliding control at the far right of the 
calculator.

New lines are always copied from the display to the bottom of the stack of 
numbers. So, the oldest calculations are on the top and the newest are on the bottom.

The paper tape can be printed by selecting the Print menu item under the File 
menu in the menu bar. To control the way numbers are printed, chose the Page Setup...
menu item.



Scientific and Complex Calculators

This section describes the functions that apply to the scientific and complex 
calculators.

When the Pi key is selected, the key will dissolve into a pop-up menu with 
several constants besides p. 

The Log key calculates the logarithm, in base 10, of the number in the display. 
The INV selector will case the key to calculate the inverse log, or 10 raised to the power 
of the value in the display.

The ln key calculates the natural logarithm, in base e, of the number in the 
display. The INV selector will case the key to calculate the inverse logarithm, or e raised 
to the power of the value in the display.

The D-R key is used to select the units of the angle that will be used for the 
trigonometric functions.

Degrees D:    360 degrees in a circle     
Radians R: 2p radians in a circle
Grads G: 400 grads in a circle
Unit Circle C: 1 unit circle in a circle

The hyp key will turn the hyperbolic trig function on and off, as indicated by the 
HYP in the upper left-hand portion of the display.

The sin key calculates the sine of the displayed number. The INV and HYP selector
will case the key to calculator the inverse sine, hyperbolic sine and the inverse 
hyperbolic sine.

The cos key calculates the cosine of the displayed number. The INV and HYP 
selector will case the key to calculator the inverse cosine, hyperbolic cosine and the 
inverse hyperbolic cosine.

The tan key calculates the tangent of the displayed number. The INV and HYP 
selector will case the key to calculator the inverse tangent, hyperbolic tangent and the 
inverse hyperbolic tangent.

Complex Calculator Only

Complex numbers are entered by inputting the real part (or magnitude) first the 
same way you would normally enter numbers, then begin entering the imaginary part (or
angle) by selecting the i key first. The choice of entering the complex number in a real 
and imaginary or magnitude and angle format is determined by selecting the P-R key. 



The following example shows how to enter the complex number 1.2+4i:

1      .      2      i      4      =      1.2 + i4

The * key will convert the display to it's complex conjugate.

The P-R key changes the way complex numbers are entered, displayed, and    
transferred to other calculators with four settings;



Real RE     
Imaginary IM
Magnitude MAG
Angle ANG

Since the other calculators can only handle one real number, the number transferred 
between calculators is determined by these four settings. Furthermore, the RE and IM 
setting will allow the entry and display of the complex number in terms of real and 
imaginary parts. When the MAG and ANG modes are selected, the entry and display of 
the complex number is done with the magnitude and angle of the number. The angle is 
displayed in degrees, radians, grads or unit circle according to the D-R setting. 



Financial Calculator     

The basic financial calculator functions are described above. The following 
explains the functions specific to the financial calculator.

The financial calculator has it's own pop up menu behind the % key. When the % 
is chosen from the pop-up menu, it converts the display into a percentage (divides the 
display by 100). The other choices in the pop-up menu will multiply the display by the 
indicated percentage (some are the current income tax rates).

The SUM key adds the display to a value in memory. The memory location is 
chosen the same way as with the STO and RCL key as explained above. 

The X! key calculates the factorial of the displayed number if it is an integer 
greater than zero.

There are four statistical function keys to perform simple statistics.    These keys 
find the mean and standard deviation of a group of numbers entered with the E key. To 
use the statistical functions, enter the data one number at a time and press the E key 
when each number is entered. Then when all the data has been entered, the mean is 
displayed by selecting the Mn key. The Sg key finds the population standard deviation 
of the data and the Sgn finds the sample standard deviation. 

 
5      5      E 5      4      E 5      1      E
5      5      E 5      3      E 5      4      E 

Mn 53.66667
  Sg 1.37437
 Sgn 1.50555

Select the key Clr twice to clear the registers before starting a new statistical 
calculation with new data.

Investment    calculations are supported by five keys. These keys are used to 
enter a value for a later calculation, or to initiate a calculation. The i key is for entering 
or finding the periodic interest rate. The N and PMT keys are used for entering or 
calculating the number of payments or the payment value respectively.    The PV and FV
keys are for entering the present or future value of an investment. You would start with 
four of these values, and then calculate the remaining one. These known values are 
entered by selecting    the STO key, then selecting one of the five investment keys:

1      0      0      0      0      0 STO      FV

The example above puts the value 100,000 in the future value register. Then the other 
three values are entered to prepare for a calculation. The remainder of this example 
calculates the interest rate needed to have $100,000 after 10 years when you start with 



$10,000 and deposit $200 a month into the account:

1      0      0      0      0 STO      PV
1      0      X      1      2      = STO      N
2      0      0    STO      PMT

i 0.01256
x      1      2      0.15071

You would need an interest rate of 1.256% per month or 15.071% per year to achieve 
the goal of 100,000.

Clicking twice on the Clr key will clear all the financial registers.



Conversion Calculator

The conversions calculator will convert between many common units of measure 
like meters to feet and Centigrade to Fahrenheit. This calculator includes some of the 
more common functions for the scientific and financial calculators. The conversions 
calculator has two extra windows next to the display that shows what units are where 
selected with the Frm key on the top and the units selected with the To key. 

There are two pop-up menus that control what units are used in the conversion 
process. You need to select two units, the units to convert from and the units to convert 
to. The pop-up menus under the Frm and To keys allow you to choose these two units. 
The menu under the To key is rebuilt when a new Frm selection is made. The example 
below shows how many meters are equal to 100 yards:

1      0      0    Frm yards
To meters 91.43551



Numerical Calculator

The Numeric calculator has 16 number keys and a pop up menu where you can 
select the base of the numbers entered and the displayed. You will also notice additional
keys for logical operations such as AND, OR and Exclusive OR. Numbers can be 
displayed in base 2, 4, 8, 10 , 12 or 16 by selecting the base from the pop up menu 
under the ^ key. The current base is displayed at the top of the display in a small 
number or letter that ranges from 2 to G.

Numbers in bases other than 10 can be manipulated like normal numbers in this 
calculator plus there are a few additional operations one can perform. Logical 
operations can be performed on long integers (between +231 and -231), but not floating 
point numbers. Before any of the logical operations, AND, OR, XOR, and NOT, the 
number is converted to a long integer. If the number is larger or smaller than a long 
integer, the results will be unpredictable.

The ASCII key prints the ASCII character (in the current font) if the number in the 
display is between 0 and 256. 

The INT key converts the displayed number to the largest integer less than the 
number in the display and sets the calculator in mode to do integer calculations.

The Flt key returns the calculator to a floating point calculation mode.

The logical operation have a lower priority than the mathematical functions which
only applies to the standard entry mode. The hierarchy of operations are multiplication 
and division first, addition and subtraction second, and the logical operations last.



The Future for CalcOne

The future for CalcOne is entirely up to you. You can exchange data files with 
other CalcOne users. As this manual goes to press, we are planning to add tools to the 
CalcOne system to make it easier to program and customize. As a registered user, you 
will get these tools as soon as they become available. Here is a list of some things we 
are working on:

1. Data file editor. There are a lot of things in a data file. What if you want to load 
some of the data?    This data file will also have the calculator's color.    If you 
change the color of the calculator it would revert to the old color when the data 
file containing the new menus is recalled. The data file editor will tell you what is 
in the data file and allow you to change items, or copy parts from other files.

2. Menu Builder. The next version of CalcOne will allow you to customize the 
pop-up menus with your own constants, percentages, or conversion units. The 
menu builder will make creating menus from scratch easy and fast by putting all 
the menu building controls at your fingertips.

3. Programability. The Macintosh CalcOne is programmable, and this feature will 
be added to the Windows version. This will allow you to automate calculations 
and solve equations.

We hope that CalcOne is a small and powerful tool for your everyday use.




